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FIVE
MICROSOFT

EXCEL TIPS TO
TURBO

CHARGE YOUR
PRODUCTIVITY



WHY DO WE NEED TO

CHANGE HOW WE USE

MICROSOFT EXCEL?

Mention Excel to some people and their eyes glaze over.  

Mention it to others and they get excited!

Like it or not, Excel is an Integral part of today's business

world.  

 

Maybe some are fearful because they were told they

were never good at math at school, or are perhaps part

of the generations not exposed to the commonplace

technology of today, resulting in anxiety and stress.   

 

In 2008 Australian company Medibank Private

conducted a report on the Cost of Workplace Stress in

Australia. In 2008 the cost to the Australian economy

was $14.81 billion per year.1

 

As a productivity expert who focuses on technology, I

see too many organisations putting pressure on their

staff to get more done in less time but not providing

them with the insights, skills or support they need to truly

feel empowered to get their work done without stress,

frustration or the need to take work home at night or

weekends!  

 

The result is increased absenteeism, presenteeism or

worse, your most valuable asset, your people, leave your

organisation in search of a less stressful or more

supportive environment.

 

Harvard Business Review's Pulse Survey2 suggests "...

fostering new work habits and processes is critical in

meeting the needs of the digital enterprise."

 

I think it is time that rather than trying to increase

productivity by adding more, we need to start viewing

what is needed in the workplace through the lens of

context and instead leveraging what we already use to

increase efficiency, and accuracy whilst reducing risk,

stress and frustration.

 

In this short whitepaper, I hope I can help kick-start your

own or your organisation's journey to a more

contemporary approach to Excel.  

 

Feel free to reach out if you'd like my help.

 

Yours in productivity,
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When I mention copying and pasting I metaphorically see those perceiving themselves as

"more advanced" with Excel rolling their eyes expecting a lecture reminiscent of a school

teacher telling students to click here, then there but never actually understanding what or

why they are doing something.

 

Reality is, sometimes with Excel we expect things to be complicated not simple.  I've lost

track of the number of times I have been shown the "long" way of how someone does

something, only to show them a couple of quick steps that shaves minutes or even hours

off the time it takes to do something.

 

Whilst a few minutes may not seem like much, on one task repeatedly undertaken, over

the course of a year, this can add up to days of lost productivity that we assume is simply

part of today's working life.

 

Copying worksheets is one tip that can literally save you hours of time!

 

Firstly, let's provide some context around how you might use this in a real life environment.  

For example, you have the same data on multiple worksheets that represents a week or a

month.

The layout is the same, it is just that the data for each period is separate. The most

common example is an annual file with tabs that represent data such as sales etc for

each month.

 

When you copy and paste the data from one sheet to another the formatting is often lost.

If you do this instead, your new worksheet ends up being an exact duplicate of the first

one.

 

1. Click on the tab you want to duplicate

2. Hold down the Ctrl key and drag the tab to the right...you will see a small + sign

3. Let go of the mouse, then let go of the Ctrl key

4. Voila a duplicated worksheet!

 

1. COPYING WORKSHEETS
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Whilst working with an executive, they told me that when they needed to send one of

their team a worksheet of their monthly sales, they saved the existing file with a new

name, deleted all the tabs they didn't want them to see, saved it, then sent it.

 

When I showed them how to send the individual worksheet, without having to save it, it

was a d'oh moment.  

 

Sometimes we get so caught up in what we are doing that we make things harder than

they need to be and we overlook the obvious.

 

Whilst the process of saving the file, removing unwanted tabs and then sending the

email might have only taken a few minutes, with five or ten staff, that could add up to a

half hour or more each time they needed to send them data.

 

By using this technique instead, that changed to moments, reducing stress, frustration

and risk and allowing the executive more time to focus on more important matters.

 

This tip saves even MORE time if you are using Microsoft Outlook for your email!!!

 

1. Right click on the tab you want to share

2. Select Move or Copy option

3. Check the Create a copy box

4. Click the drop arrow to the right of the current file name and choose (new book)

5. Click OK

6. Click the File tab and choose Share 

7. Choose to attach the file as an Excel workbook or PDF

8. Type in the email address of the person you wish to sent it to

9. Click Send.

 

 

  

 

2. SENDING AN INDIVIDUAL

WORKSHEET
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They say a picture is worth a thousand words.  

 Graphs can be particularly challenging, but with a few little tips, a visual representation

of your Excel data can totally change how your reader understands and analyses the

information you are presenting. 

  

 

When I work with executives and their teams, these simple tip can save them hours of

stress and frustration, particularly when they need to create a graph five minutes before

going into a client pitch or board meeting.

 

Whilst this tip will cover creating a simple graph, for one participant in a session it shave

a two hours off the graphing process, EVERY SINGLE time she created a graph!

 

The key lies in LEVERAGING Excel to do the hard work of graph creation for you.

If the graph isn't what you want, it is often because the data isn't appropriately laid out

to make it easy for Excel to create.

The graph is merely a reflection of your data.

 

To create a quick and simple graph

 

1. Highlight (select) the data you want to graph (be sure to include any labels but don't

include any totals as generally you will want the graph to compare say month by month

or product by product)

2. Press the F11 key on the keyboard (note if you are on a laptop, depending on the

brand or model, in order to access the F11 key you may need to combine it with a button

with text such as FN on it)

 

Excel has now created a graph on a separate worksheet for you to create axis, data

labels and titles as needed.

 

The graph can be moved back to appear beside your data 

To do this click Move Chart, select Object in, from the droplist select the relevant

worksheet, then click OK. 

 

 

  

 

3. CREATING QUICK GRAPHS
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Many of the executives and teams I work with have spreadsheets where data is the

same across multiple worksheets.

 

Whilst we covered a tip on how to easily duplicate worksheets including the formatting,

at times there are changes that need to be made on every single worksheet.

 

If there is only one or two, that's easy, but if you have 10, 12 or more it can be time

consuming.  

 

The next tip enables you to make global changes in your worksheet to the same cell in

every worksheet.

 

This has proved extremely useful for clients who want to duplicate a file for another

team or division but don't want to have to go through and edit titles or names that are in

the same cell on every worksheet.

 

NOTE: This tip enables you to edit or enter text into the same location on multiple

worksheets at the same time.  

 

 

Let's just say I have a budget for a division of the company. In cell A1 at the top of each

of my 12 worksheets in the file is the heading Finance Department and I want to change

it to Customer Service.

Here's how we do it.

1. Click on the first worksheet tab in the file

2. Hold down the Shift key and click on the last worksheet tab in the file (note if you

can't see it on screen, use the right pointing arrows to navigate so you can see it)

3. At the top of the screen it should indicate the file name and in [Group]

4. This means your worksheets are now grouped.  Any changes you make to any cells will

impact on that same cell on EVERY worksheet.

5. Click on cell A1 (in this example)

6. Edit or retype in Customer Service and press Enter

7. Ungroup the worksheets by right clicking on one of the tabs and choosing Ungroup.

 

You've now changes the contents of A1 in every single worksheet in this file.

 

 

 

4. GLOBAL CHANGES
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When preparing to work with a firm of accountants I conducted our standard pre-session

survey which enables us to customise our programs to focus on the ideas and strategies

that will enable those attending to fast track their productivity.

 

One of the questions I asked was "What is the 1 thing that if you knew it, understood it or

felt it would make attending this session valuable to you?"

 

The response surprised me.  The attendee simply wanted to know to Freeze Panes. 

 Which basically means how to "lock" the column or row headings in a spreadsheet to

ensure when you view it on screen the labels at the top of a list continue to display as

you scroll down.

 

Now this attendee could have easily gone to Google or YouTube for the answer, but

they had so much to do that they hadn't found the time.

 

This tip is particularly useful if you are like a lot of the organisations I work with who are

analysing and manipulating large volumes of data.

 

Here's how we do it.

 

1. Click on the first cell below the column heading and to the right of the row heading

(this might be B2 if your headings are in row 1 and column A)

2. Click the View tab and choose Freeze Panes

3. Select Freeze Panes to "lock" the spreadsheet with data above and to the left of your

current cell "locked", Click Freeze Top Row if you want to freeze ONLY the top row   

 (row 1) of your spreadsheet, Click Freeze First Column if you want to freeze ONLY the

first column (column A) of your spreadsheet.

 

As you scroll down the spreadsheet you will notice the relevant headings DO NOT move.

To remove the frozen panes, return to the View tab and choose Unfreeze Panes.

 

NOTE: If you Freeze Panes and then save the file, next time you open the file the panes

will still be frozen.

 

 

5. FREEZE PANES
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WHAT'S NEXT?

Want help kickstarting you or your team's new

year by getting productive with Microsoft Excel,

or Word, Outlook or PowerPoint?

 

I'd love to help.

 

Here's how I can help:

 

I can deliver a customised 2020 "Kick Start"

Productivity session for your team or organisation

either in person or virtually.

 

Interested or want more details?

  

Contact my office on +61 39457 4745 or email

enquiries@donnahanson.com.au

 

Want more free stuff??

 

Subscribe to my YouTube channel for regular insights

and tips on productivity go to

https://tinyurl.com/DHSubscribe

 

Sign up to my free monthly productivity pointer

eNewsletter at www.donnahanson.com.au

 

Or connect with me on LinkedIn, (mention this ebook

so I know to accept you right away!), follow me on

Facebook or Twitter. 

 

Feel free to pass this whitepaper on to anyone you

think would benefit from its contents.

 

I hope it helps you improve your productivity in 2020.

Have a great year
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Subscribe to my YouTube channel for regular insights 
and tips on productivity go to  
https://tinyurl.com/DHSubscribe

Sign up to my free monthly productivity pointer 
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Or connect with me on LinkedIn, (mention this ebook 
so I know to accept you right away!), follow me on 
Facebook or Twitter.

Feel free to pass this ebook on to anyone you think 
would benefit from its contents.

I hope this ebook helps you improve your productivity.
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